Research

Research is the process of gathering information to use in technical report, a cover letter, or even in a procedure. How you research depends on what you intend to do:

- **Procedures** – step-by-step instructions how to do something – are best researched by actually trying to accomplish the task. It is also helpful to look at existing procedures for similar tasks to see how “the other guys” did it.
- **Cover letters for résumé** are best researched by investigating the target company on the web and in the library (magazine articles, annual reports), and by talking to knowledgeable employees; investigating the hiring manager on the web (especially LinkedIn.com and Facebook) and through personal contacts; and investigating the job itself by reading the job posting/advertisement and by talking to company employees in similar positions.
- **Research reports** (also known as term papers, technical reports, etc.) are best researched in the Library (books and technical journals) and in on-line data bases (e.g., Lexus-Nexus). Research reports are not “how to” guides, skim-the-surface overviews, or persuasive papers hiding as information. Research reports must have all resources cited. Research reports usually require multiple references; yours requires 5-10 credible references.

“Credible” references are those that are widely accepted as being factual and accurate. Scientific journals are a great example, but less-rigorous sources will also work: published books, web sites, interviews, surveys, etc. Wikipedia is improving, but it is still not an acceptable reference for most educational papers. However, it’s a great place to start your research. You can quickly explore your topic, find keywords for further search, and find links to “real” references that you can use. Caution: Be very attuned to the biases of your sources.

The LBCC Librarians – a Great Resource!

The Library lecture was given by Bryan Miyagishima (miyagibg@linnbenton.edu, 917-4646). Bryan and his colleagues are incredibly knowledgeable about research processes and tools, and are eager to help you with general questions and requests for specific materials. Visit them!

The Library web page is available from the LBCC home page. In the upper right corner of the screen, click Quick Links and choose Library. Bryan maintains course-specific pages on the LBCC Library website. Access the WR 227 Research Guide at: http://library.linnbenton.edu/content.php?pid=206303

Choosing a Topic for your WR227 Technical Research Report – Part 1

When choosing a research topic, you’ll find that it’s easier to research things that are well-known (because there is a lot of information) and/or existing (because the information is more likely to be factual rather than speculative).

With a 7-10 page paper (4-7 pages of body), it is very easy to pick too large a topic, resulting in an “emergency culling” as you get close to the deadline. It’s also easy to pick a topic that’s too
small, leaving you searching for more information (or making it up!) the night before the project is due. So think hard, not only about the topic, but about what you’ll do with it. Plan!

When choosing a topic, be specific. Being too general will result in a “fluffy” paper that does not go into enough depth for the audience (a variety of LBCC instructors in various subjects). So rather than “Martial Arts,” think “The Origin of Kung Fu”. A broad topic also may present you with far too many references and sources, and will overwhelm you with choices about what to put in and leave out.

Be sure that the topic you choose has enough credible research sources. In this class, you can use one or two informal sources (magazines, newspapers, TV shows, non-scientific websites, etc.). But in general, you need to go to academic, scientific, or government publications, websites, and other media.

Remember that the report must be objective and neutral, so you will need to include all “sides” in your research, and you’ll need to be careful that the topic doesn’t display a bias (e.g., “Why Orcs are Despicable Creatures”). The tone of this report must be formal, and suited for your audience (LBCC instructors in a variety of disciplines). Finally, don’t choose a frivolous topic, but don’t be afraid to do a serious report on something that isn’t very serious (e.g., “The Effect of Cotton Candy on Dental Health”).

Finally (in general), think about the potential primary audience for your report. Will it be for your boss, the readers of a scientific journal, subscribers to a local newspaper, your classmates, etc.? (Note: For the WR227 Technical Research Report assignment, your instructor is your primary audience.)

If you are having trouble deciding on or narrowing down your topic, you are encouraged to consult with a Librarian, go to the Writing Center (they will help you brainstorm), or ask me.

Finding Sources – The Literature Review

When researching, investigate and scan many resources, then pick the appropriate ones. Don’t over-cite resources just to look impressive; only cite the ones you use! Remember, though: You are required to use at least 5 – and preferably 10 – references for your Technical Research Report assignments.

The LBCC Library (LBCC home page → Quick Links (upper right corner) → Library) has a variety of tools for finding sources; many of these tools will format your citations for you(!):

- On the Library home page, the Find It box is a terrific place to start.
- Also on the Library home page, in the Research Tools area, try Academic Search Premier.
- Finally, again in the Library home page, in the Research Tools area, click All Databases. On the page that appears, WorldCat (worldcat.org, which will search the LBCC Library, the OSU Library, and many others) and Films on Demand are the most popular resources.
- Ebook Central, a great search tool with the complete text of many books and sources that you can fully search, and a handy highlighter and note-taker feature. On the Library home page, click Ebook Central in the Research Tools box. You’ll be presented with a sign-in box. (By signing in, you will be able to save highlighted points, notes you write, etc.)
• **EBSCO.** On the Library home page, choose **Academic Search Premier** in the Research Tools box. (Note: **EBSCO** does not always link to the full text of an article; you may have to request that via interlibrary loan.)

• On the Library home page, click **Course Research Guides** in the Research Tools box. On the right side of the page that follows, the Video Tutorials provide instructions on many of the tools. (The **WR 227 Research Guide** link in the center column also leads to some useful resources.)

• The librarians can direct you to specialized data bases (agriculture, etc.), can help you find and order materials from off-site libraries, can provide advice on research, and can make themselves invaluable in many ways. Ask them!

• Of course, the library also has its own on-line “card catalog” you can use. This will let you see all of the “real” books in the Library, grouped together by subject. Click **Library Catalog** in the Research Tools box. Fill in the fields and click **Browse**. Choose a book you’re interested in, and its companions will also be shown.

• You can search the OSU Library by clicking **Search Other Libraries** in the Use the Library area. If you’re searching the OSU site, click on a book, then click on its call number to see all the nearby books on the shelf. Note that searching the OSU Library will return all media, not just books.

If you already have connected with a Librarian, you may wish to create a working bibliography storage that the Librarian can see (so she or he can help you):

1. Log into your LBCC (Google) email account.
2. Click on the ☁️ icon at the top right of the screen.
3. Choose Drive from the list of icons that appears.
4. In Drive, click on Create, then Document.
5. Name the new document “WR227 Working Bibliography <last name> <first name>”.
6. Click Share.
7. Add the email of the Librarian as a sharer, and set that sharer to “Can view” only. If you wish, add other people who will be helping you.
8. Click Share, then Save, then Done.

Google Scholar (**Scholar.Google.com**) or “regular” Google is also a great way to identify source materials. Do a Google search on your topic, then click the “more” link at the top of the page (next to the Gmail link). Choose Books from the dropdown, and you’ll get displays of books on the topic. Many books have previews that you can read, and some even present the entire text of the book. In Google Scholar, search for “pdf” to return results that are available in text form.

Nifty Google Scholar feature: Click ≃, then Settings. Check the box for “Linn-Benton Community College – Available at LBCC” and click the Save button. When you search, resources in the LBCC databases now will be displayed!

The LBCC Library can get books from many other libraries on inter-library loan. The OSU Library is open to everyone, and has a huge stock of books and other materials. (If you are a Corvallis resident or co-registered at OSU, you can get a library card and check out materials.)

**Expanding or Refining Your Search.**

When searching, consider “truncating” your search term; that is, use an asterisk (*) as a “wild card” so that the search will return all results containing the letters before the asterisk. For
example, searching on “athle*” will return, athlete, athletics, and so on. Place the asterisk carefully so the search does not return too many possibilities or irrelevant items.

In EBSCO, when your search returns a list of references, the list is likely to be large. Find a reference that looks likely and click on it. The Subject Terms list will give you the ability to narrow your search to a more specific range.

In EBSCO, on the initial search screen, you can click “Full Text” to restrict the search to references that are accessible directly through EBSCO (i.e., that don’t need an interlibrary loan to get). There are other fields and boxes that will help you to narrow your search further. One very easy way is to add another required search term (e.g., to “tattoo” add “cancer”); use the Search Modes buttons to choose whether all or some terms are required.

You can save EBSCO articles to your Google drive.

**Choosing a Topic for your WR227 Technical Research Report – Part 2**

If you are having trouble coming up with a topic, you might look at the “Opposing Viewpoints” page. (On the Library home page, in the Research Tools area, click the Opposing Viewpoints link. Remember, your report itself must be objective, but it can consist of balanced coverage of all sides of a controversial topic.

**Citations**

You are required to cite all of your sources, whether used for background information, plagiarized, or quoted. We’ll talk a lot more about this in a few weeks. In the mean time, be aware that the tools Bryan talked about can save you a lot of time (and mistakes) when formatting citations.

In order of decreasing usefulness and/or ease of use, they are:

- WorldCat. This is a great tool not only for finding sources, but also for creating the correct citation for them. Find and open the book, click on Cite/Export near the top of the screen, click the “+” next to APA or MLA, then copy and paste the formatted citation into your bibliography.
- Ebscohost. This is also available through the LBCC Library. Search a topic, and click on the chosen source; on the right, under Tools, click Cite, then copy and paste the result.
- Films On Demand (same access as WorldCat) has a Citations button at the page bottom.
- Your own word processor. Microsoft Word, for example, has a Citations and Bibliography function in the References tab. You fill in a form, and it creates the citation. Warning: The Word-generated format is often wrong!
- The APA or MLA Style Guide (or web sites). These will give you instructions for formatting your own citations the hard way.
- Citation applications like EndNote or Reference Manager. (These are expensive and are probably overkill for community college work.)
**Plagiarism**

*Plagiarism* is using someone else’s words, pictures, ideas, concepts, etc. and representing them as your own. It’s illegal and immoral; it can get you fired, sued, thrown out of school, and/or discredited professionally. In this class, it will earn your assignment an instant “no credit”.

**Warning!**

LBCC requires staff to report all instances of plagiarism. If you are in any doubt about what you have done could be considered plagiarism, ask your instructor, a librarian, or someone in the Writing Center!

The most obvious examples are when you copy material directly out of a book or a web site and paste it into your own document, and then fail to cite your source (i.e., mention that you did this and where you got the material from). If you copy material, you must enclose it in quotation marks and cite the source.

**Avoiding Plagiarism.**

You must cite every use of outside material even if you reword it substantially (paraphrase it), because you are taking the knowledge as well as the words themselves. But simply citing a source does not get you off the hook. In this class, I expect you to write original material, using outside sources to research details. If more than 5% of your assignment comes directly from outside sources – quoted, cited, paraphrased, reworded, disguised, or just plain stolen – you will receive zero credit for that assignment.

Remember, put as much information as you like in your “pile” or “stash,” but extract only keywords, dates, names, etc. into your working notes, being sure to also record where you got them.

There’s a good (short) tutorial on plagiarism on the LBCC Library web site. You also can access it directly at: [http://lib.usm.edu/plagiarism_tutorial.html](http://lib.usm.edu/plagiarism_tutorial.html).

For more information on plagiarism and fair use, visit the Purdue O.W.L. website’s Using Research section: [https://owl.english.purdue.edu/owl/section/2/9/](https://owl.english.purdue.edu/owl/section/2/9/).

**Copyright**

The vast majority of resources that you will find are copyrighted. That means they are owned by someone, and you must get the owner’s permission to use the work. If you are writing commercially, or you are working on academic writing that could be published or reprinted, this in an important consideration. For community college papers, you are very likely to be able to skate by this permission requirement, although you still must cite your source.
Academic Fair Use

Academic Fair Use is a provision of copyright law that lets you use work without permission, but with citation. It applies to the papers you write for this class, provided that you don’t reuse or republish them elsewhere.

The Baylor University checklist (https://www.baylor.edu/content/services/document.php/68621.pdf) is a great tool for determining whether your work qualifies for Academic Free Use. Check the applicable boxes at the bottom, and score the results. (You will likely check only left-column boxes, earning “Strongly favors fair use” for your work.)

Images that Don’t Require Permission

While the Internet is a treasure trove of images, they are not there for the picking. In most cases, images are copyrighted (owned) by someone; you must get their permission before using them even in student papers (academic fair usage excepted). To save yourself the trouble of obtaining permission, consider using license-free images.

- **Google Images**: Search on images as usual. When the results appear, click on Settings (above the images) and choose Advanced Search. Scroll down to the bottom of the resulting screen to Usage Rights. In the dropdown, choose the applicable Free To Use option and click Advanced Search.

- **Creative Commons** (https://creativecommons.org/): Click on Use & Remix. On the resulting page, take note of How to Give Attribution! You must cite what you take, even though you do not need permission to use it. Enter your term in the Search box and click Search. In the resulting page, you’ll be presented with a number of sources containing images. Choose the source, and continue your search there.
Résumés (cont.): (Note: These were in last week’s summary too.)

Writing the References Section

Detailed references were once a required part of a résumé, but now are usually included only when specifically requested by the employer.

- If you are instructed by the employer to enclose references, it’s best to put them on a separate page attached to your résumé. That way, you can maintain the references separately, and can leave them off if they aren’t requested.
- If you must include references:
  - Use a prominent heading (“References”) similar to your other headings.
  - Include the name, title, and contact information for each reference. Emails and phone numbers are better (and more likely to be used) than addresses.
  - Differentiate between personal references and professional references.
- It’s preferable to use a “references placeholder”: either use the line “References available on request” or put “Available on request” under the References heading.
- Reasons not to include your actual references if not asked to do so:
  - They take up a lot of space.
  - They may be “stale” by the time your résumé is used.
  - Employers know you’re only including people who will say great things about you.
  - Your references are unlikely to be checked unless you’re a finalist, and the odds are low. Why subject yourself to the disadvantages?

Writing the Traits/Highlights/Summary/whatever… Section

There are important points in your résumé that you desperately want the reader to see. Why risk those points being missed because they’re lost in the detail or far down in the document? Put them right up at the top.

- Put anything important in here.
- Put this section at the very top of the résumé, right under the contact information. (Where the Job Objective would be before you learned not to include it!)
- Use the fewest possible words in each point. Single words, 2-3 words, or phrases are best.
- Use bullets to clearly delineate points.
- Use multiple columns, carefully lined up vertically to look good, for the highest information density.
- Use Tabs, not the space bar, to line up text.
- Put the most important points at the top left.
**Brainstorming and Outlining**

The first major task in a technical communication process is planning. The larger the project, the more you need to plan it. Planning will give you a better product, but it will also save you time in the long run! It’s far easier to rearrange or redesign in the early stages.

Many of us were forced to do outlines in high school, but few of us benefitted from the exercise. At first, outlines seem an unnatural way to do things. As a preliminary step, consider brainstorming. One way is to use Post-It Notes™.

1. Relax, clear your mind, and think about your project. As each thought comes to you, jot it on its own note. Don’t worry about grammar, spelling, whole sentences vs. words, pictures vs. text, or any other detail – just capture whatever comes into your mind. When you get tired, take a break and then come back to it. When you finish, stick the notes on a wall.

2. Look at them, then move them around until they are grouped into similar topics. If you find duplicates, keep just one. If you think of something new, make a new note.
3. Organize the groups into the sequence you think should be in the final report.

4. Organize each group into subtopics, details, etc. Add more notes as you think of things. Feel free to create several levels of subcategories.

5. Translate your thoughts into outline form on paper or in a word processor. Use any letters, Roman numerals, numbers, etc. that you want – nobody will care!
6. The wall becomes…

Turning an Outline into a Report

Think of your outline as a skeleton. “Pump up” the skeleton by adding “muscles” – the important text that fills in the major information. You can work on a “bone” at a time, or work on the whole thing from beginning to end – your choice.

Once the important information is in place, add the “skin” etc. – the fine details, descriptive language, and perhaps illustrations that make the paper interesting as well as informative.

As a last step, “pretty up” your creation by polishing your writing, correcting errors, proofreading, getting peer review, etc.
Outlining and Heading Formats in Word

Word has a powerful Outline feature that is well-integrated with its heading format and automatic Table of Contents generator. Unlike OpenOffice Writer, you can easily switch back and forth between Outline and normal views.

Creating an Outline:
1. Click the View tab, then Outline (in the Document Views pane).
2. Type the text of a heading. By default, it will be in ordinary Body Text format.
3. In far left side of the menu, click the single left arrow to promote the text to become a level-1 heading.
4. Press Enter to advance to the next line, which will still be in level-1 heading format.
5. To demote the text to Body Text, click the double right arrow, or to demote it to level-2 head format, click the single right arrow.
6. To rearrange material, drag the “plus” or “minus” icon in the left margin of the text to the desired place.
7. To collapse a heading and its contents so only the heading shows, click the Minus sign in the menu below the single and double arrows. To expand it back, click the Plus sign.
8. At any time, to switch to Word’s normal view, click the Close Outline View “X” in the menu bar.

Setting Heading Levels:
You can set heading levels in existing text, or you can set heading levels as you type:
1. Click the Home tab.
2. Highlight the text you wish to turn into a heading, or set the cursor at the beginning of the line where you intend to type a heading.
3. Choose Heading 1, Heading 2, or Heading 3 in the Styles area to turn the highlighted text or text you’ll type into a heading.
4. To turn a heading into normal body text, highlight it and choose ¶ Normal.

Changing Heading Formats:
1. Click the Home tab.
2. Change the font, color, bold, point size, etc. of a heading to the format you wish.
3. Right-click on the heading’s box in the Styles area.

Outlining and Heading Formats in LibreOffice (OpenOffice) Writer

Writer does not have as fancy an outline feature as Word does, and creating an outline and formatting headings are two separate processes. It’s much easier to not use Writer’s outliner feature. Instead, just write your outline in the normal view, and format the various levels as headings.
Setting Heading Levels:

1. Type the heading's text, but don't press Enter, so the cursor remains on the text's line. (Or select an existing heading you wish to format.)
2. In the far left side of the menu, locate the dropdown list to the left of the font selector dropdown. It will probably say “Default”. Alternately, click Format, then Styles and Formatting, to bring up a movable box that displays all heading levels you can choose.
3. Click the dropdown's arrow and choose the heading level you want, or double-click on the desired heading level in the box.
4. Repeat this process for other headings, or choose “Default” for body text.

Changing Heading Formats:

1. Click Format, then Styles and Formatting, to bring up a movable box that displays all heading levels you can choose.
2. In the movable box, right-click on the heading level of that heading, and choose Modify.
3. Select the tab that corresponds with what you want to change, then make the changes. When done, click OK. All headings of that level will change to the new format.

Using the outliner feature (if you really want to):

1. Click the Format menu, then choose Bullets and Numbering.
2. Choose the outline style you want, then click OK.
3. The numeral/number/letter for the first level-1 head will be placed in the text.
4. Click after it, then type the text of the heading.
5. Press Enter once, and the next heading label will appear.
6. To “demote” any head to the next lower level, put the cursor to the left of the numeral and press Tab. To “promote” a head, press Shift-Tab.
7. To add ordinary body text after a head, put the cursor at the end of the head and press Enter twice.
8. If you move a heading and its subordinate material using cut-and-paste, the pasted material will all become top-level heads (inconvenient!).

Note that setting outline numbering does not apply a heading style; that must be done separately. The outline numbering will remain even after the heading style has been applied. To get rid of the numbering, highlight the heading(s) and click the Numbering button on the menu bar (once or twice, as needed to get rid of the numbers.)